Mobile Users
Mobile users overview
Using Windows 2000, you can make network files available while working offline (for example, while working on a portable computer). Any shared network files or folders, including program files and Web pages, can be made available offline. By first setting up your computer to use Offline Files and then making your files available for offline use, you can disconnect your computer from the network and the files will still be available for use on your computer just as though you were still connected.
When you return your portable computer to its docking station, or when your network connection is restored, changes you made to files on your computer while you were disconnected are synchronized with those on the network.
In addition, you can use Briefcase to save and synchronize network files quickly and easily, using either a Briefcase stored on a portable computer or a Briefcase stored on a removable disk.
To undock a portable computer 
 1.
Click Start. 
 2.
Click Eject PC. A message appears, saying it is safe to undock your computer. 
 3.
Undock your portable computer, or, if you have a motorized docking station, your portable computer will automatically undock. 
Notes

If Eject PC does not appear on the Start menu, use the Add/Remove Hardware wizard in Control Panel to remove the portable computer for the first time. 

If Eject PC still does not appear on the Start menu, then your computer may not support undocking or you may not have security privileges to undock your portable computer. See your administrator for these privileges. 

Some computers have an eject button on the docking station. Pressing that button instead of following this procedure also undocks the laptop. Read the manufacturer's instructions for more information. 

To work on files or folders that are located on the network, ensure that you make the item available on your undocked laptop. 

For optimal laptop performance, you should change your power scheme using Power Options in Control Panel. 

Programs located on a network will not be available on your laptop when you undock. 
To set up your computer to use Offline Files
 1.
Open My Computer. 
 2.
On the Tools menu, click Folder Options. 
 3.
On the Offline Files tab, make sure that the Enable Offline Files check box is selected. 
 4.
Select Synchronize all offline files before logging off to get a full synchronization. Leave it unselected for a quick synchronization. 
Notes

To open My Computer, double-click My Computer on your desktop. 

A full synchronization ensures that you have the most current versions of every network file that has been made available offline. A quick synchronization ensures that you have complete versions of all your offline files, though they may not necessarily be the most current versions. 

By default, the Enable Offline Files check box is selected in Windows 2000 Professional but is cleared in Windows 2000 Server. 

Even if your computer is configured to use Offline Files, you must still select the network files and folders that you want to make available offline. 

To view a list of all of the network files that are available offline, on the Offline Files tab, click View Files. 
To make a file or folder available offline
 1.
In My Computer or My Network Places, click the shared network file or folder that you want to make available offline. 
 2.
On the File menu, click Make Available Offline. 
Important

Make Available Offline will appear on the File menu only if your computer was set up to use Offline Files. 
Notes

The first time you make an item available offline, the Offline Files wizard will guide you through the process. When the Synchronizing dialog box disappears, the item is available offline.

Individual files from a shared network folder or an entire shared network folder can be made available offline. If an entire folder is made available offline, any files placed in that shared folder will automatically be made available offline the next time the computers are synchronized. 

If a shortcut to a file is made available offline, that file is made available offline, but if a shortcut to a folder is made available offline, the contents of that folder will not be made available offline. 

When the status of your network connection changes, an Offline Files icon appears in the status area, and an informational balloon is displayed over the status area to notify you of the change. If the informational balloon notifies you that you are offline, you can continue to work with your files as you normally do, or you can click the Offline Files icon in the status area for more information about the status of your connection. 

To undo making a file or folder available offline, right-click the item and click Make Available Offline again to remove the check mark. 
To schedule offline items to synchronize
 1.
Open Synchronization Manager. 
 2.
Click Setup, and then click the Scheduled tab. 
 3.
Click Add to start the Scheduled Synchronization wizard, which assists you in creating a synchronization schedule. 
Note

To change or remove an existing synchronization schedule, on the Scheduled tab, click the existing schedule, and then click either Edit or Remove. 
To synchronize offline items
 1.
Open Synchronization Manager. 
 2.
Select the check boxes beside the offline items that you want to synchronize, such as a mapped network drive or an Internet Explorer offline Web page. 
 3.
Click Synchronize. 
Note

To synchronize individual files, folders, or Web pages in Windows Explorer, My Computer, or Internet Explorer, click the item that you want to synchronize, and then on the Tools menu, click Synchronize. 
To synchronize files stored on a removable disk using Briefcase 
 1.
Insert a removable disk into a disk drive on your main computer. 
 2.
Open Briefcase. Copy the appropriate files to Briefcase. 
 3.
Drag Briefcase to the disk. 

The files in Briefcase are copied to the disk.
 4.
Remove the disk from your main computer and insert it into a disk drive on your portable computer. 
 5.
Open Briefcase from the disk and work on the files. When you are ready to synchronize the files, remove the disk from your portable computer and reinsert it into a disk drive on your main computer. 
 6.
Open Briefcase from the disk, and then do one of the following: 

To update all the files, on the Briefcase menu, click Update All. 

To update only some of the files, select the files you want to update, and then on the Briefcase menu, click Update Selection. 
To choose a power scheme
 1.
Open Power Options in Control Panel. 
 2.
Under Power Schemes, select the power scheme you want. The power settings you see will change depending on the power scheme you choose. 
Notes

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

Preset time settings appear in the Turn off monitor and Turn off hard disks lists of the Power Schemes tab. You can change these settings by clicking the arrow and then clicking the time you want. 

You can create a new power scheme by clicking the time settings you want, clicking Save As, and typing a name. 

Using Power Options in Control Panel, you can adjust any power management option that your computer's hardware configuration supports. Because these options may vary widely from computer to computer, the options described may differ from those available on your computer. Power Options automatically detects what is available on your computer and shows you only the options that you can control.
To manually put your computer into hibernation
 1.
Open Power Options in Control Panel. 
 2.
Click the Hibernate tab, and then select the Enable hibernate support check box. 

If the Hibernate tab is not available, your computer does not support this feature.
 3.
Click OK to close the Power Options dialog box. 
 4.
Click Start, and then click Shut Down. On the Shut Down Windows dialog box, click Hibernate. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

When you put your computer into hibernation, everything in computer memory is saved on your hard disk. When you turn the computer back on, all programs and documents that were open when you turned the computer off are restored on the desktop. 

To put your computer into hibernation, you must have a computer that is set up by the manufacturer to support this option. 

Using Power Options in Control Panel, you can adjust any power management option that your computer's hardware configuration supports. Because these options may vary widely from computer to computer, the options described may differ from those available on your computer. Power Options automatically detects what is available on your computer and shows you only the options that you can control.
To create a hardware profile
 1.
Open System in Control Panel. 
 2.
On the Hardware tab, click Hardware Profiles. 
 3.
Under Available hardware profiles, click Profile 1 (Current). 
 4.
Click Copy, type a name for the new hardware profile, and then click OK. 
 5.
You can customize your new profile by enabling or disabling devices for that profile in Device Manager. 
Notes

You must be logged on as an administrator to the local computer to copy or create hardware profiles. 

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

The profile named Profile 1 (Current) provides a model for you to create new hardware profiles. It will not appear in the list of available hardware profiles shown during startup. 

To open Device Manager, click Start, point to Settings, click Control Panel, double-click System, click the Hardware tab, and then click Device Manager. 
Windows 2000 troubleshooters
The following troubleshooters are available on Windows 2000. You can start a troubleshooter by clicking the name that is highlighted in the left column of the table. 
Troubleshooter
Identifies and resolves problems related to:
Client Service for NetWare
Client Service for NetWare, including accessing NetWare servers and Novell Directory Services (NDS) objects, printing to NetWare printers, using NetWare login scripts, and logging onto an NDS tree.
Display
Video cards and display adapters, including your computer screen, outdated or incompatible video drivers, and incorrect settings for your video hardware.
Hardware
Cameras, CD-ROM drives, game controllers, hard drives, keyboards, mouse devices, network adapter cards, and scanners. If you are having problems with a sound card, a modem, or a display or video adapter card, this troubleshooter may help you, but you can also see the individual troubleshooters for those devices.
Internet connections (ISP)
Connecting and logging on to your Internet service provider (ISP).
Modem
Modem connections, setup, configuration, and detection.
MS-DOS programs
Running MS-DOS programs on Windows 2000.
Multimedia and games
Installing and configuring DirectX drivers and games. 
Networking (TCP/IP)
Internet and intranet connections that use Transmission Control Protocol/Internet Protocol (TCP/IP) on a computer running Windows 2000 Professional.
Print 
Network or local printers and plotters, including outdated or corrupted printer drivers, network and local printer connections, and printer configuration. 
Remote access
Network and dial-up connections that use a telephone to connect your computer to another computer.
Sound
Sound cards and speakers.
System setup
Installing and setting up Windows 2000.
Windows 3.x programs
Running 16-bit Windows programs on Windows 2000. If you are having problems running an MS-DOS program, see the MS-DOS troubleshooter.
